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Chapter 5 

Financial Comparisons 
It is difficult to compare the values of dissimilar items, which makes choosing between them difficult. In 

early times, people would barter services for goods such as putting new shoes on a horse in exchange for 

three chickens. Agreeing on a trade required a lot of qualitative discussions about the relative merits of the 

goods and services and choosing between service providers (or chickens) was primarily a qualitative 

decision. Over time, this system was replaced with the concept of money. Money is represented by paper and 

metal coins but in the computer age, most money exists in computers as quantitative numbers. Money is a 

quantitative tool for representing the value of goods and services. 

1 Cash Flow and Simple Payback 

Learning Objectives 
1. Identify positive and negative cash flows. [5.1.1] 

2. Define and apply the concept of simple payback. [5.1.2] 

3. Identify the assumptions and limitations of using simple payback for 

comparison of projects [5.1.3] 

4. Describe how changing the terms of the loan can change the cash 

flow. [5.1.4] 

5. Identify and apply the concept of return on investment. [5.1.5] 

6. Identify and apply the role of present value in decision making. 
[5.1.6] 

Making choices between projects is often reduced to comparing quantitative numbers. When a green energy 

project is considered by an organization, the managers of the organization must combine qualitative 

reasoning with quantitative analysis of how much the project will cost and what its monetary benefits will be. 

To get green projects funded for qualitative reasons, proponents must understand how quantitative 

comparisons are made and the assumptions that influence the numbers. In many cases, a green project can be 

competitive if favorable assumptions are made and all of the costs and benefits are included. The same 
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principles apply to any other project that is taken on by a company and the skills you learn in this section can 

be applied to many different types of situations. 

The negative number in the loan example in the previous chapter indicates an underlying financial 

concept called cash flow. Cash can be thought of like water. Cash that is flowing into your account is positive 

and cash that is flowing out is negative. If you borrow money, the lender transfers the money to your account 

which would be positive. When you transfer money back to the borrower as a payment, the payment is a 

negative cash flow.  

A business must be very aware of its cash flow. A project might be profitable in the long run, but if 

the company does not have enough cash to pay its employees in any given month during that project they 

might go out of business or have to borrow more money which raises the cost of the project. 

Consider the cash flow for a project where extra insulation is added to reduce heating costs. In this 

example, the homeowner took out a loan for $1,000 at 6% annual interest for five years. The monthly 

payment is $19.33. The savings on heating is $200 for the year but that savings is not spread equally, as 

shown in Figure 5.1. 

 

Figure 5.1. The loan payments are made monthly, but the savings in heat only occur in the 

winter months. 

In this example, money saved is shown as positive cash flow (less of a negative utility payment). The 

cash flow for the month on this project is positive in the winter months when the heating bills are high but 

negative the rest of the year. During the months when the cash flow is negative, the money would have to 

come from another source. If we look at the annual cash flow of this project, as shown in Figure 5.2, the cash 
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flow is negative each of the first five years while the loan is being repaid. 

 

Figure 5.2. Negative cash flow for the first five years 

Small projects that are intended to save money in the long run by spending money now are often 

compared using a measure that is easy to calculate called the simple payback. The simple payback is 

calculated using the following formula: 

Simple payback = Initial Expense / Savings per year 

In the previous example, the simple payback would five years: 

Simple payback = $1,000 / $200 per year = 5 years 

The simple payback is used to answer the question; “How long will it take to get our money back and 

start profiting from the initial expense?” If two projects both cost about the same but one of them has a 

shorter payback, the project with the shorter payback has the advantage.  

Simple payback has limitations. It assumes the following: 

  the savings or additional income is the same each year  

 there are no maintenance costs that occur periodically  

 there are no changes during the period considered  

 the cost of borrowing money is not considered  

 it does not cost anything extra to remove the equipment at the end of its life  

Most business managers assume that a short payback of less than two years indicates that the project 

will probably make enough money to justify the expense. 

It is important to recognize how competitive the business environment is. About a third of new small 

businesses fail within the first two years and less than half are still in business after four years. Three of the 
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top four reasons for failure are related to cash flow. They are 

 too much debt 

 overspending 

 lack of reserve funds. (AllBusiness 2010) 

The owners of small businesses might be willing to invest in a green energy project but it could put 

them out of business if it causes negative cash flow in the first few years. Small businesses that survive have 

done so by managing their money carefully to avoid cash flow shortfalls and to make more money than their 

competitors. 

Once a company gets large enough, the owners sell shares of the company to raise money to expand. 

The people who buy the shares—shareholders—want the greatest value for their investment and they use two 

quantitative values to make that comparison; the profits of the company and the value of their share in the 

company. In most cases, the shareholders hire a professional manager to choose which company’s shares to 

buy. If a company’s profits are less than those of a competitor, the managers sell the company’s shares and 

buy those of its competitor. The managers themselves are compared on how well they do at picking the best 

companies in which to invest. The result of this system is that even large companies must choose projects 

that are the most profitable. All of us who have retirement and insurance funds are part of this system. To get 

green projects approved, they must be as financially acceptable as other options or close enough so that 

qualitative arguments can tip the balance in their favor. To get the chance for approval, advocates of green 

energy projects must know how financial managers make quantitative comparisons. 

Large companies that have shareholders must issue periodic reports that describe the financial 

condition of the company. These reports are done quarterly—every three months—and annually. Most 

companies will accept a project that has a negative cash flow for a few quarters. Projects that have negative 

cash flows for more than one year are harder to get approved because they cause the company to show a loss 

for that project on the annual report. Most companies are reluctant to approve a project that has a simple 
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payback longer than eighteen months because they do not want to show a loss for two years in a row. 

One way to meet this short payback requirement is to change the conditions of the loan to lower the 

annual payments—the negative cash flow—so that the outflow is less than the savings. The PMT function 

used to calculate the monthly loan payment has three inputs; principal, interest rate, and number of payments. 

By changing the conditions of the loan, the annual loan payment can be reduced below the annual savings, 

resulting in a positive cash flow. Three ways to reduce the loan payment below the energy savings to create a 

positive cash flow are: 

 reduce the amount borrowed by lowering the cost of the project 

 lower the interest rate 

 increase the time period of the loan 

The company can negotiate a lower price for the project or it can apply for a subsidy from a local 

government agency. The worksheet has been changed to include the option for a subsidy that reduces the cost 

of the project. If the project received a subsidy of $150, the cash flow would be positive, as shown in Figure 

5.3. 
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Figure 5.3. Positive cash flow resulting from a subsidy 

Government subsidies are most effective if they are used to motivate companies to take risks on new 

technologies or to increase the number of green energy devices being sold to reduce the cost of making them 

so that they will eventually cost less due to the savings that come with larger production runs.  

Another option is to reduce the risk to the bank by guaranteeing that they will get their money back or 

by loaning them money at a lower than normal interest rate so they can make loans for energy projects at 

lower rates. If interest rates are already low, this method is less effective than if they are high. For example, if 

the interest rate on the loan is decreased from 6% to 1%, the cash flow is still negative, as shown in Figure 

5.4.  

 

Figure 5.4. Subsidized interest rates lower payments. 

The third option is to increase the number of payments by lengthening the period of the loan. 

Governments can encourage banks to lend money for longer periods on untested technology by guaranteeing 

the loan thereby reducing the risk of loaning money for longer periods. For example, if the term of the loan 

was changed from five years to six, the result would be a positive cash flow, as shown in Figure 5.5. 
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Figure 5.5. Increasing the years of the loan can create a positive cash flow. 

The concept of simple payback is useful because it is easy to understand and to calculate. It is 

assumed that if a project has a simple payback of less than eighteen months it will probably be a good use of 

the company’s money. Many companies place an arbitrary threshold of one year or eighteen months for the 

simple payback for projects that are less than a certain dollar amount. If a project has a five year payback, 

like the original example, it would not make the cut for consideration. 

Some proponents of green or sustainable energy projects for homeowners argue that a payback that is 

shorter than the number of years that the owner plans to live in the house is acceptable. In general, your 

family’s finances should be well managed. If a project has a simple payback of more than a few years, it is 

advisable to consider other projects or financing options that reduce the payback period to avoid cash flow 

problems of your own. You may also find yourself limited by the financing options that are available, or the 

terms and conditions that a bank or other financial institution is willing to offer. 

Return on Investment (ROI) 

Another relatively simple number that is calculated for comparison of energy projects is the return on 
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investment (ROI). The return on investment is calculated using the following formula: 

ROI = (Gains – Cost) / Cost  

Notice that the formula does not include the unit of time. Using our example, we could calculate the 

ROI for five years and get 0%. 

ROI = ($200/yr ∙ 5yrs - $1000) / $1000 = ($1000 - $1000) / $1000 = 0/$1000 = 0% 

If the time period is extended to seven years, the result is very different. 

ROI = ($200/yr ∙ 7yrs - $1000) / $1000 = ($1400 - $1000) / $1000 = $400/$1000 = .40 = 40% 

To use ROI to make comparisons, the time periods must be the same for both projects that are being 

compared. To calculate ROI in our example, find the gains by summing the savings for nine years, as shown 

in Figure 5.6. 

 

 

Figure 5.6. ROI calculation. 

In this figure, the ROI will be 80% [(200∙9 – 1000)/1000] which sounds like a great return on 

investment if you can only get a few percent on a savings account. The term investment must be used 

carefully. Installing insulation or buying equipment that generates electricity from the sun or wind is very 
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different than putting money into a savings account or buying stocks. With savings accounts or stocks, you 

can easily get all or most of your money back at any time. Once you put money into installing insulation or 

buying and installing equipment, you can get very little of it back. Like the concept of simple payback, ROI 

is useful because it is simple and easy to calculate. It can also be used incorrectly. To use it correctly for 

comparing two projects;  

 Both projects must be evaluated for the same period of time. 

 Both must involve buying equipment or making improvements that become a permanent 

addition and cannot be easily removed or sold. 

Upon further investigation, the homeowner in our example found that the furnace in the home was an 

older model that had a transformation efficiency of 60%. A new model is available that would transform 95% 

of the natural gas into useable heat within the home. To provide the same heat to the home, the furnace with 

the higher efficiency would use less natural gas. This would reduce the annual bill for natural gas from 

$2,000 to $1,263. Installation of the new furnace would be $1,500. To compare the option of installing 

insulation versus buying a new furnace, the simple payback and ROI are calculated first for the insulation 

option, as shown in Figure 5.7. 

 

Figure 5.7. Insulation project 

The insulation project has a negative cash flow for five years, a simple payback of 5 years, and an 
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ROI of 80% for nine years. 

The same calculations are made for the new furnace project, as shown in Figure 5.8. 

 

Figure 5.8. New Furnace project. 

The new furnace costs more ($1,500 vs. $1,000) but it has a positive cash flow, a shorter payback (2 

vs. 5) and a much higher ROI (342% vs. 80%). The ROI are both based on buying something that cannot be 

sold easily and it is for the same period of time (9yrs). Using these three tools, it is clear that the new furnace 

has the advantage and should be ranked above the insulation project when considering which projects to do. 

Present Value 

The value of money depends on when you have it. The promise of a dollar paid or saved in the future is 

worth less than a dollar in hand today. To determine how much less, there are several factors to consider: 

 Risk—what is the chance that you will not receive the dollar in the future 

 Reduced buying power—a dollar in the future might buy fewer services or goods; also known as the 

rate of inflation. 

 Opportunity cost—the dollar might be used on another project or investment that is better 

 Cost of raising the money—if the dollar is borrowed, interest will have to be paid on the loan 

All of these factors are considered by the finance department of the company and they arrive at the 

discount rate. The discount rate is a percentage by which future dollars are reduced in value each year so they 
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can be compared with today’s dollars. The present value of a future amount is found with the following 

formula: 

PV = FV/ (1+DiscountRate)yrs  

In this example, the present value of the $200 savings two years in the future at a 9% discount rate 

would be : 

PV = $200 / (1+.09)2 = $200 / [(1.09)∙(1.09)] = $200 / 1.1881 = $168.34 

Excel has a function that does this calculation for all the values in a range of cells and then adds the 

values to get a total. The total is called the net present value (NPV).  

The NPV function has two arguments; the discount rate and a range of cells. It is assumed that the 

time period of the rate and the time interval between each cell is the same. In other words, if you use an 

annual discount rate, the time between the values in the cells must be one year. The net present value for the 

insulation project is shown in Figure 5.9. 

 

Figure 5.9. Sum of the initial cost plus the present values of future savings for insulation. 

The net present value of the initial cost plus the flow of money in the future is $199.05 more than the 

cost of the money. 

A similar analysis of the furnace project shows another advantage of the NPV method. It can take into 

consideration additional future expenses such as periodic maintenance and removal of old equipment, as 
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shown in Figure 5.10. 

 

Figure 5.10. Sum of the initial cost of a new furnace plus the present values of future savings 

and expenses 

Larger companies often have many small projects that compete for a fixed amount of money. Most 

companies simply set a threshold for consideration. The threshold could be a minimum payback period of 

two years or an ROI of 100% in two years. The projects that meet the threshold requirement are then ranked 

based on their payback or ROI. The company would then choose from the ranked list of projects starting with 

the projects at the top. Qualitative considerations might enter in at this point but if the energy project did not 

make the cut it will not even be discussed. Larger projects are often ranked by their net present value.  

If green energy projects do not meet minimum threshold requirements for consideration, it might be 

necessary to request that management set separate threshold standards such as longer payback periods, lower 

ROI or longer periods of time for ROI calculations. Once an energy project qualifies to be included in the list 

of possible projects, qualitative arguments in favor of reducing reliance on foreign oil or cleaner air might be 

persuasive. 

Key Takeaways 
 Money out is negative cash flow and money in is positive. Reducing the money going out can be 
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considered a positive cash flow for comparison purposes. [5.1.1] 

 For projects where an expense is incurred in order to increase cash flow in the future, the simple 

payback is the initial expense divided by the annual savings or additional income. [5.1.2] 

 The simple payback method assumes that the savings or additional income is the same each year, 

there are no maintenance costs that occur periodically, and there is no consideration of changes or 

increases during the period considered. [5.1.3] 

 The cash flow can be made positive or less negative by reducing the terms of the loan by reducing 

the amount borrowed, reducing the interest rate, or by increasing the number of years to repay the 

loan. [5.1.4] 

 Return on investment (ROI) may be used for comparison if the projects involve buying or 

installing equipment that cannot be readily sold to recover its value and the period of years are the 

same. The ROI is a percentage that represents the ratio of the difference between the gains and 

cost to the cost. [5.1.5] 

 The value of future income and expenses is reduced by the discount rate. The total present value 

of all the expenses and incomes of a project shows how much more money the project is worth 

than the money would cost the company to obtain. [5.1.6] 

2 Compare Investment Options Using Excel 

Learning Objectives 
1. Format by typing an example and align currency values with other 
numbers. [5.2.1] 

2. Enter cell references in a dialog box or formula by clicking the cell. 

[5.2.2] 

3. Fill using a selected interval of values. [5.2.3] 

4. Recognize the difference between rounded numbers displayed in 

cells and numbers stored in cells. [5.2.4] 
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5. Use the Format Painter to transfer formatting. [5.2.5] 

Comparing financial options begins with a calculation of cash flow for a period of time that is likely to 

include the useful life of the equipment. In this section, you apply what you have learned about prices of 

energy and financial analysis to compare investments in higher mileage cars and alternative sources of 

electricity such as wind and solar and you practice Excel skills that are necessary for working with financial 

analysis tools. The skills you practice with these examples are the same skills you would use to evaluate a 

wide variety of other investments. 

More fuel efficient automobile 

This exercise applies the skills demonstrated for analyzing the present value of an investment that is intended 

to save or make money. 

Buying a car is generally not considered an investment because under normal circumstances it will 

decrease in value during its life and produce negative cash flow each year. However, if the buyer spends 

more for a model that uses less fuel, the additional money could be considered an investment and the annual 

fuel savings can be considered as positive cash flow.  

The numbers used in this example are from Edmunds (Edmunds 2008) <Link>. The comparison is 

between a 2009 Honda Civic and a 2009 Honda Civic Hybrid. 

1. In the Ch05FinanceStudentName.xlsx workbook, at the bottom of the window, click the Hybrid sheet tab. 

2. In cell B3, type 15000 and then on the Formula bar, click the Enter button. Apply the comma style and 

reduce the decimal places to none. Observe that the number 15,000 has a small space to the right. 

3. In cell B4, type $2.91 and then press Enter. Observe that by typing the dollar sign, the cell is formatted to 

use a dollar sign. Observe that the right side of the numbers in B3 and B4 align. 

4. In cell B5, type 30.0 and then on the Formula bar, click the Enter button. Observe that the number does 

not align with the numbers in cells B3 and B4. Apply the Comma style and reduce the decimal places to 

one. This is the combined city and highway mileage. Observe that the right side of the number aligns 

http://www.edmunds.com/advice/fueleconomy/articles/116513/article.html
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with the price and mileage numbers above it. 

5. In cell B6, type =B3/B5 and then on the Formula bar, click the Enter button. Apply the Comma style and 

reduce the decimal places to none. 

6. In cell B7, type 42.3 and then on the Formula bar, click the Enter button. Apply the Comma style and 

reduce the decimal places to one. 

7. In cell B8, type =B3/B7 and then on the Formula bar, click the Enter button. Apply the Comma style and 

reduce the decimal places to none. 

8. In cell B10, type =(B6-B8)*B4 and then press Enter. Recall that the order of mathematical operations is 

to do the multiplication and division first from left to right and then do the addition and subtraction. 

When a different sequence is desired, such as in this formula, parentheses are used to indicate which part 

of the formula should be done first. 

9. Compare your worksheet to Figure 5.11. 

 

Figure 5.11. Savings from higher mileage in a hybrid 

10. In cell B12, type $18,825 and then press Enter. In cell B13, type $24,220 and then press Enter. 

11. In cell B14, type $0 and then press Enter. 

12. In cell B15, type =B13-B12-B14  and then press Enter. Observe that the additional cost of buying a more 

fuel efficient hybrid is $5,395. 
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13. In cell B17, type =B15 and then press Enter. We will assume that the car loan will be increased by $5,395 

minus any tax rebate and just consider the increased cost as if it were a separate investment. 

14. In cell B18, type 6% and then press Enter.  

15. In cell B19, type =B18/12 and then on the Formula bar, click the Enter button. On the Home tab, in the 

Number group, click the Percent style button, . Use the skills you practiced earlier to increase the 

decimals displayed to two. 

16. In cell B20, type 4 and then apply the comma style with no decimal places displayed. 

17. In cell B21, type =B20*12 and then press Enter. Compare your worksheet to Figure 5.12. 

 

Figure 5.12. Calculating the additional amount paid for the more fuel efficient car 

18. Click cell B22. On the Formula bar, click the Insert Function button, . The Insert Function dialog box 

displays. 

19. In the dialog box, click the category arrow, and then click Financial. Under Select a function, scroll down 

and click on PMT, as shown in Figure 5.13. 
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Figure 5.13. PMT function and its arguments 

20. In the dialog box, click OK. 

21. In the Function Arguments dialog box, click the Rate box. Type B19 and then press the Tab key. 

Tip: Instead of typing the cell addresses into the dialog box, you can click the cell on the worksheet and 
the cell address will be entered. 

22. In the Function arguments dialog box, click in the Nper box, and then on the worksheet click cell B21. 

23. Click in the Pv box, type B17 and then compare your worksheet to Figure 5.14. Observe that the values 

of each cell are displayed to the right and the payment is displayed as a negative number. 
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Figure 5.14. Preliminary payment estimate based on arguments 

24. In the dialog box, click the OK button. The payment is displayed in cell B22 as a negative number, as 

shown in Figure 5.15. Observe the parenthesis used to indicate a negative number uses the space to the 

right of the number and that all of the numbers in this column are aligned on the right. 
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Figure 5.15. Additional payment for more fuel efficient vehicle 

25. In cell B24, type 0% and then press Enter. In cell B25, type 2011 and then press the Tab key. In cell C25, 

type 2012 and then press the Tab key. 

26. Select cells B25 and C25. Drag the fill handle to the right to cell I25. The sequence of years is filled to 

2018. 

Tip: To extend a sequence, select the first two cells of the sequence to determine the interval 
between them, and then drag the fill handle to fill the sequence into adjacent cells. 

27. In cell B26, type = and then click cell B17.  Observe that cell references can be placed in a formula by 

clicking the cell. Press Tab. The loan amount is transferred to the cell. 

28. In cell C26, type =$B$22*12 and then on the Formula bar click the Enter button. The monthly payment is 

multiplied by 12 to calculate the annual payment. An absolute reference is used so the formula can be 

filled. Alternatively, you could have typed the equals sign, clicked B22, pressed the F4 key to add the 

dollar signs, and then typed *12. 

29. Fill the formula in cell C26 into cells D26:F26. The loan was for four years. If this loan period is 

changed, the cells into which the formula is filled must be manually revised. 
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Tip: Automating some features of a spreadsheet are possible but they might take a lot of work. 
If you know of a hidden design issue like this one, use a comment to alert future users. 

30. Click cell B20. Add the following comment; If the number of years are changed from 4, revise row 26. 

31. In cell C27, type =B10 and then press the Tab key. This formula transfers the annual gasoline savings 

from cell B10. 

32. In cell D27, type =C27*(1+$B$24) and then on the Formula bar click the Enter button. 

Tip: To find a percentage increase, multiply by 1 plus the percentage. To find a percentage 
decrease, multiply by 1 minus the percentage. 

33. Fill the formula in cell D27 into cells E27:I27.  

34. Click cell C27. On the Home tab, in the Clipboard group, click the Format Painter button, . Drag cells 

D27:I27.  Observe that the format from cell C27 is applied to the cells. 

35. Click cell C28. On the Home tab, in the Editing group, click the AutoSum button, . Observe that the 

program assumes the year in cell C25 should be included in the range to be summed, as shown in Figure 

5.16. 

 

Figure 5.16. Automatic SUM function mistakes the year for a number that should be included 

in the range to be summed . 

Tip: Always check the range that is chosen by the program to catch errors of this kind. 

36. Drag cells C26:C27 to correct the error, and then click the SUM button a second time. Observe that the 
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cash flow is a negative $1,097. 

37. Fill the formula in cell C28 into cells D28:I28. Observe that the cash flow is negative for the four years 

during which loan payments are made. 

38. In cell B24, type 10% and then press Enter. Observe how the savings in gasoline increases by 10% each 

year over the previous year, as shown in Figure 5.17. 

 

Figure 5.17. Increases in gasoline prices included . 

39. In cell B30, type =B15/B10 and then press Enter. Format the number to display one decimal place. 

Observe that the display is rounded from 12.75157 to 12.8. The simple payback is approximately 12.8 

years. 

Tip: Always remember that the display might be rounded off and the actual number might have more 
decimal places. The actual number will be used by any formula that refers to the cell. 

40. In cell B31, type =(SUM(C27:I27)-B15)/B15 and then on the Formula bar click the Enter button.  

41. On the Home tab, in the Number group, click the Percent Style button. Recall that the ROI is the 

difference between the savings and the original cost divided by the original cost. In this case, the original 

cost is more than the savings in eight years so the ROI is a negative 26%. 

42. In cell B24, type 0% and then press Enter. Observe that without the expected annual increase of 10% in 

gasoline price the ROI becomes -45%. The simple payback is not affected because it does not consider 

future changes in savings or costs. 

43. In cell B33, type 6% and then press Enter. 

44. In cell B34, type =-B26+NPV(B33,C27:I27) and then press Enter. Recall that the net present value 
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(NPV) is the sum of the initial cost which is a negative cash flow plus the present value of a series of 

future savings that are discounted by the discount rate. 

Tip: Watch for minus signs in formulas because they are easily overlooked. There is a minus sign 
between the = and B26 in the previous formula. 

45. Compare your worksheet to Figure 5.18. For Net present value, we consider that the extra expense is paid 

up front without a loan so it is a negative number. To that is added the net present value of the gasoline 

savings. Observe that the NPV is a negative $3,033 which means that the gasoline savings will not pay 

for the additional cost of the car within its 7 year life. 

 

Figure 5.18. Long payback, negative ROI, and negative NPV . 

46. Use the skills you practiced previously to put your name in the worksheet header on the left side, the 

class name in the center of the header, and the current date in the right side of the header. Change the 

page orientation to Landscape. Save the workbook. 

In a later chapter, you will return to this topic to determine what factors in this financial analysis 

would have to change in order to make the investment in a more fuel efficient vehicle a competitive option. 

Wind Turbine 

In this section, you review an analysis that uses the energy prices from the previous chapter to analyze an 

investment in a wind turbine, and then practice creating functions and formulas to perform a financial 

analysis. 

1. In Ch05FinancesStudentName, click the Wind sheet tab. The initial calculation of savings is divided into 

sections that show savings for on-peak and off-peak energy and demand charge savings, as shown in 
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Figure 5.18. This analysis has several assumptions, including an assumption that the energy will be used 

by a company or large building that pays for electricity on a demand rate. 

 

Figure 5.18. Savings estimate for a wind turbine using business style electric rates. 

2. Move the pointer to cell A3, and then read the comment. Click cell B3. Observe that the maximum 

energy per month is the product of the maximum power in B2, the hours in a day, and the hours in a 

month. 

3. Click cell B5. Observe that the expected energy per month is the maximum possible multiplied by the 

capacity factor. 
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4. Move the pointer to cell A8. The comment informs the reader of the assumption of 21 days a month that 

are business days (M-F). Click cell B8. Observe that the percentage of on peak hours is calculated by 

dividing the product of the on peak hours (8) and the business days per month (21) by the product of the 

hours per day (24) and the days per month (30). 

5. Click cell B9. The energy savings is calculated by multiplying the expected energy per month by the 

percent that is on peak. 

6. Move the pointer to cell A10, and then read the comment. Click cell B10. Observe that the on peak 

energy charge is the sum of the energy and distribution charges from the primary service rate. 

7. Click cell B11, observe that the on peak energy savings is the product of the energy in B9 and the price in 

B10. 

8. Click cells B14 through B17 to review how the off peak energy savings is calculated. 

9. Move the pointer to cell A20, and then read the comment. The wind will not reliably reduce the demand 

charge each month. One way to estimate the effect on the demand charge is to use the capacity factor to 

estimate what percentage of the months will have a demand charge reduction and use that as an average 

for each month. 

10. Click the cells from B22 through B26. 

Tip: As of 2010, small wind turbine systems and small solar electric systems cost about $6 per watt 
installed. For example, a 10kW (10,000 watt) system would cost about $60,000. This price is likely to 
decrease if more systems are manufactured and if new technologies reduce costs. 

11. Click cell B35. Type =PMT(B33/12,B34*12,B32) and then on the Formula bar click the Enter button. 

Observe that the function arguments can contain mathematical operations. This method saves space but 

imbeds assumptions into the formula itself. 

12. Click cell C39. Observe that the monthly yearly loan payments are the product of the monthly loan 

payment and the number of months per year. An absolute value is used so the formula can be filled. 

13. Click cell C39, drag the fill handle to cell G39. Observe that the number of cells into which the formula is 
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filled is determined by the number of years of the loan in cell B34. 

14. Click cell C40. Observe that this savings is the product of the money saved per month from B26 and the 

number of months per year. 

15. Click cell D40. Observe that this formula calculates a percentage increase from the value in the cell to the 

left based on the value in cell B37. An absolute value is used so the formula can be filled. 

16. On cell D40, drag the fill handle to cell K40. This analysis assumes a life of ten years for the equipment 

and that they will be in this building for ten years. 

17. Click cell C41. The net cash flow each year is the sum of the loan payments and the savings. Drag the fill 

handle to K41. 

18. Click cell B37. Type 5 and then press Enter. Compare your worksheet to Figure 5.19. 

 

Figure 5.19. Cash flow assuming a 5% annual price increase. 

19. Click cell B43. Type =B32/C40 and then on the Formula bar, click the Enter button. Observe that the 

simple payback is the cost less the tax credit divided by the annual savings. In this instance, the simple 

payback is much longer than the expected life of the equipment. 

20. Click cell B44. Type =(SUM(C40:K40)-B32)/B32 and then on the Formula bar, click the Enter button. 

The gain is the sum of the savings for the ten year period. Recall that the ROI is the gain minus the cost 

divided by the cost. In this example, the ROI is negative because the savings are less than the cost. 

21. Click cell B46. Type =-B32+NPV(B45,C40:K40) and then on the Formula bar, click the Enter button. 



   

 

26 | P a g e  

 

The net present value is the sum of the present expense which is the cost of the project in B32. Notice a 

minus sign is used to make this value negative to indicate that we are paying out this amount at the 

beginning of the project. The NPV function calculates the present value of the savings in C40:K40, 

discounted by the rate in cell B45.  The savings in this example are much less than the cost so the NPV is 

negative.  

22. Compare your screen to Figure 5.20. 

 

Figure 5.20. Financial values for a 10kW wind turbine. 

The financial analysis for the hybrid car and the wind energy options are not favorable. You will learn about 

options in later sections for changing these results. 

Key Takeaways 
 A cell can be formatted by first typing a number and then applying a format using buttons or 

dialog boxes. Alternatively, if you include formatting such as dollar signs, percent signs, and 

commas the program will apply that format to the cell. If some of the values in a column will use 

parentheses to indicate negative numbers, a comma, number, or currency style should be used that 

reserves a space for the parenthesis in positive numbers. [5.2.1] 

 An alternative to typing a cell reference in a formula or dialog box is to click the cell. [5.2.2] 

 To specify an interval between values in a series when it is filled, use the first two cells in the 

series to define the interval, select both of them, and then drag the fill handle. [5.2.3] 

 If you decrease the number of decimal places that are displayed, the display is rounded but the 
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actual number remains. The actual number is used by any formula or function that refers to that 

cell. [5.2.4] 

 To copy the format of a cell, click the Format Painter button in the Clipboard group on the Home 

tab and then drag the target cells. [5.2.5] 

3 Taxes, Depreciation, and Price Increases 

Learning Objectives 
1. Identify the effect of taxes and depreciation on project finances. 

[5.3.1] 

2. Identify the effect of energy price changes on net present value. 

[5.3.2] 

3. Use the zoon level to view large worksheets. [5.3.3] 

Governments can discourage certain practices or uses of energy by adding a tax to raise the price as they do 

for gasoline in Europe. Another way that governments can influence the behavior of people and companies is 

to reduce the taxes they pay on their income. In this section, you learn how tax incentives can be used to 

encourage adoption of green energy practices and projects by improving the financial comparison of those 

options with other sources of energy. 

Tax Credits 

A tax credit is a simple reduction of the amount of tax the person or company has to pay. For example, in 

2011, the U.S. Government is giving a $7,500 tax credit to individuals who buy an electric car. The State of 

California is granting an additional $5,000 in a credit on state taxes. This means that a person who pays more 

than $7,500 in federal taxes would pay $7,500 less in the year they bought the car and if they pay more than 

$5,000 in California state taxes, they would pay $5,000 less in state taxes. The price of the Nissan Leaf is 

about $31,000. If a resident of California buys that car in 2011, they would pay $12,500 less in taxes that 

year thereby reducing the initial expense of the car to $18,500. Governments use tax credits to encourage 

adoption of new behaviors and they are usually offered for a limited time. 
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Tax Deduction 

A tax deduction is an amount that the person or company can deduct from their earnings before the earnings 

are taxed. For example, if there is a federal tax deduction of $100, the person or company can deduct that 

much from their income before the federal tax is calculated. If the tax is 20%, they would pay $20 less tax. 

Many people confuse a tax credit and a tax deduction but the difference is large. A tax credit of $100 is worth 

$100 but a tax deduction is only worth about $20. 

Depreciation 

If a company buys a piece of equipment that is used to help the company make or save money, the company 

can subtract the cost of the equipment from the money it earns before they pay taxes on the earnings, which 

is a form of tax deduction. The fraction of the equipment’s initial value that can be subtracted is related to 

how much value the equipment has lost because a used piece of equipment is worth less than a new one. The 

amount of reduced value is the depreciation. The simplest method is to estimate the useful life of the 

equipment and divide the initial price by that number of years. For example, if the $1,500 furnace has a 

useful life of fifteen years,  a company could deduct $100 from its earnings each year before taxes are 

calculated. Assuming a 25% tax rate, this would be an additional positive cash flow of $25 each year. 

Apportioning an equal amount of the original price to each year of the equipment’s life is called straight line 

depreciation.  

Governments can encourage the purchase of certain types of equipment by assuming shorter time 

periods for depreciation. For example, if the furnace was depreciated over five years instead of fifteen, the 

deduction would be $300 per year with a resulting tax savings of $75 per year. 

Another common method of improving the tax deduction for equipment is to allow a larger amount to 

be subtracted in the early years. For example, the depreciation can be calculated by taking 40% each year of 

the remaining value of the equipment for five years. This method is called the declining balance depreciation 

method. For example, the amount subtracted from earnings the each year would be: 
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Year one: $600; (1500∙40%); tax savings at 25% =  $150.00 

Year two: $360; (900∙40%); tax savings at 25% =  $90.00 

Year three: $216; (540∙40%); tax savings at 25% =  $54.00 

Year four: $129.60; (324∙40%); tax savings at 25% =  $32.40 

Year five: $77.76; (194.40∙40%); tax savings at 25% =  $19.44 

The advantage of the declining balance method is that the company gets most of the tax credit in the 

first few years when it has a greater present value, as shown in Figure 5.21. 

 

Figure 5.21. Tax savings increase cash flow for equipment depreciation. 

The tax savings increase the net present value almost $300 ($2,843 from $2,552). If a company has 

invested in equipment that is not energy efficient, they will be reluctant to replace it with more efficient 

equipment if they are still getting tax credits for the depreciation of the equipment. 

Price Increases 

The price of energy is difficult to predict. Consider the price historiy of natural gas (U.S. Energy Information 

Administration 2010), as shown in Figure 5.22. 
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Figure 5.22. Natural gas prices. 

In the five years from 2000 to 2005, the price increased from about $7.50 per MCF ($.75 per CCF) to 

about $12.50 per MCF ($1.25 per CCF). This is an increase of about 13% per year. During the period from 

2005 to 2010 it fluctuated widely and ended up at about the same price. If the price of energy is expected to 

increase during the time period under consideration, it will shorten the payback or increase the ROI and NPV 

values for an investment in an energy saving technology. If we assume that the next nine years will see price 

increases in natural gas that are similar to the period from 2000 to 2005, we would increase the savings by 

13% per year. 

An option for energy price increases can be included by multiplying the savings of the previous year 

by 1+13%, as shown in Figure 5.23. 
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Figure 5.24. Including an annual price increase for energy increases NPV. 

Assuming a price increase of 13% per year makes a large difference in the net present value of future 

energy savings. If you are evaluating claims made by someone who is selling an energy saving device, 

determine what assumptions they have made about future energy prices to see if they are likely to occur. If 

you are promoting the purchase of energy saving devices, be sure you can support your assumption of annual 

price increases. This is a good place to prepare a chart based on past energy prices and to use a trend line to 

project future prices. 

Hybrid car 

The government can encourage the use of fuel efficient vehicles by giving tax rebates or by adding taxes to 

the price of gasoline. Use the worksheet you created to observe how these tools of  government can affect the 

financial measures of payback, ROI, and NPV. 

1. Open Ch05FinancesStudentName, and then click the Hybrid sheet tab.  

2. At the lower right corner of the screen, on the Zoom Level bar, , drag the 
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pointer or click the minus sign to adjust the magnification of the screen so that you can see rows 1 

through 34 at the same time. 

3. Observe that the three financial comparison factors are: 

a. Simple payback: 12.8 years 

b. ROI: -45% 

c. NPV: -$3,033 

4. In cell B14, type 2000 and then press Enter. Observe that the formatting of the cell does not change and 

the value is displayed with a dollar sign. Observe that the three factors are now: 

a. Simple payback: 8 years 

b. ROI: -13% 

c. NPV: $967 

5. In cell B14, type 0 and then press Enter. Another option is to add taxes to the price of gasoline as they do 

in some countries in Europe.  

6. In cell B4, type 6 and then press Enter. Observe that the formatting of the cell is applied to the number. 

Observe that the three financial comparison factors are now: 

a. Simple payback: 6.2 years 

b. ROI: 13% 

c. NPV: -$525 

7. Save the workbook. 

Key Takeaways 
 Taxes can be used to discourage some types of behavior by making it more expensive. Tax credits 

and tax deductions reduce the amount of tax paid to encourage certain decisions. Equipment can 

be depreciated more in early years or in less time to increase the tax savings [5.3.1] 
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 The future value of energy savings can be increased if the cost of fuel increases. Assuming an 

annual increase can have a large impact on the net present value of the project. [5.3.2] 

 Use the zoom level bar at the lower right corner of the screen to change the magnification of the 

screen to show more rows and columns if necessary to view the whole worksheet. [5.3.3] 

4 Comparing Options 

Learning Objectives 
1. Identify characteristics of design that facilitate “What-if” analysis. 

[5.4.1] 

1. Use Goal Seek to identify inputs that produce desired outcomes 

[5.4.2] 

3. Identify ranges with names. [5.4.3] 

4. Identify uses of scenarios for facilitating comparison. [5.4.4] 

Computers are very fast at recalculating formulas, which makes it practical to try several different options to 

find a solution to a problem. Repeated efforts are call iterations. In this section, the rapid processing 

capability of the computer is used to find options. 

Designing for “What-if” analysis 

To make the most of the rapid recalculation ability of the computer, it is necessary to design the worksheet so 

that the values that are changeable are located in the same area and that any formula that uses one of those 

values refers to the cell in which it is located. This design principle has been used in previous chapters. For 

example, a Home Improvement Loan worksheet begins with the conditions of the loan at the top, as shown in 

Figure 5.25. An assumption was made that the payments would be made monthly. 
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Figure 5.25. Consider assumptions built into formulas. 

The number 12 is used in the formulas B7 and B9 to calculate the monthly interest rate and number of 

months. Some business loans have quarterly payments—every 3 months—and this assumption would not be 

appropriate. A more flexible design that would be useable for a variety of circumstances would identify this 

assumption and place the number in its own cell, as shown in Figure 5.26. 

 

Figure 5.26. Design changed to display payments per year so that it can be changed. 

Spreadsheet is an accounting term for a range of calculations that projects the effects of financial 

decisions, and the range can to be very wide and spread out to accommodate many columns and rows of 

calculations. Microsoft prefers the term worksheet but programs like Excel are generically referred to as 
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spreadsheet programs. For example, to evaluate a loan to buy a new furnace and its effects on the heating bill 

can be spread out for ten years, as shown in Figure 5.27. 

 

Figure 5.27. Spreadsheet of effect of new furnace. 

If one of the initial values, such as the cost of the project, tax credit, interest rate, years, or anticipated 

savings is changed, all of the formulas in the spreadsheet that depend upon the value are recalculated. The 

speed of the computer makes it practical to try different combinations of values to see what would happen. 

This is called what-if analysis. For example, if a lower estimate of the savings is used in cell B12, the change 

affects all of the formulas that depend upon it directly or indirectly, as shown in Figure 5.28. 
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Figure 5.28. Dependent formulas recalculated when the anticipated savings is reduced. 

If the worksheet is designed for what-if analysis, a user can try many options quickly. To avoid 

accidentally replacing a formula by typing a number, it is a good idea to provide visual clues to identify 

which cells are used for input values and which ones should not be overwritten because they contain 

formulas. Providing a border around the input cells can provide such a visual clue, as shown in Figure 5.29. 
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Figure 5.29. Visual clues indicate which cells can be changed by the user. 

If the intended user is not familiar with the design of the worksheet’s formulas, they might overwrite 

a formula and cause a malfunction of the worksheet. To prevent accidental inputs into cells that contain 

formulas, the worksheet can be protected. There are several levels of protection available. The workbook, 

worksheet, and cells can be protected. The default relationship between the worksheet and the cells are that 

they are either protected or unprotected together. The term used for this relationship in Excel is locked. If the 

worksheet is protected, then all of its cells are protected from change by default. To make exceptions for 

particular cells, the relationship between the cell’s protection and the worksheet must be unlocked. The 

process has three steps: 

1. The cells intended for user input are selected. 

2. The cells are unlocked—relationship to the worksheet’s protection is removed 

3. The worksheet protection is turned on. 

The result is that all of the cells in the worksheet are protected from accidental change, except those 

whose relationship to the worksheet is unlocked. If the user attempts to change a protected cell, an error 

message displays, as shown in Figure 3.30. 
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Figure 5.30. Error message displays for protected cell. 

A password can be used but passwords are usually unnecessary if the only purpose is to prevent 

accidental changes to formulas.  

1. Open Ch05FinancesStudentName, if necessary, and click the Hybrid sheet tab. 

2. Click cell B3. Press and hold the Shift key, and then click cell B5. Cells B3:B5 are selected. 

Tip: To select a group of adjacent cells, click the first cell, press and hold the Shift key, and then click the 
cell at the opposite end or corner of the range. To select cells that are not adjacent, press and hold the 
CTRL key and click each cell individually. 

3. Press and hold the CTRL key. Click cells B7, B12, B13, B14, B18, B20, and B33.  

4. On the Home tab, in the Font group, click the arrow on the Borders button, . On the menu, click 

Outside borders.  

5. Click another cell on the worksheet to deselect the cells, and then compare your screen to Figure 5.31. 
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Figure 5.31. Cells intended for user input indicated with a border. 

6. Use the skill you just practiced to select those cells again.  

7. Right-click any one of the selected cells. On the shortcut menu, click Format Cells. 

8. In the Format Cells dialog box, on the Protection tab, click the Locked check box to deselect it. Compare 

your screen to Figure 5.32. 
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Figure 5.32. Selected cells unlocked. 

9. Click OK. These cells are no longer locked into the same protection as the rest of the sheet. 

10. On the Review tab, in the Changes group, click the Protect Sheet button. 

11. Confirm that no password is used and that the first to options are selected, and then click OK. 

12. Click cell B6. This cell contains a formula that should not be accidentally overwritten. Type a number. A 

warning box displays. Read the warning and then click OK. 

13. Click cell B4, type $2.91 and then press Enter. The unlocked cells may be changed. 
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Tip: If the sheet is protected, the next time you click the Review tab you will see that the button in the 
Changes group has changed to Unprotect Sheet. This button switches back and forth depending on 
which operation is appropriate.  Unprotecting the sheet will not change the locked or unlocked status of 
individual cells. 

Iterative problem solving with one input 

If the user has a particular goal in mind, he or she can try several values as inputs to see how they affect the 

output value. After a few tries, it will become clear what input values result in an output that is too high and 

what values result in an output that is too low. Using the output to adjust the input is called feedback. By 

using the output to make more informed guesses about the input, the outcome becomes progressively closer 

to the desired result. For example, a resident of Michigan is considering buying an electric car. He compares 

the Nissan Leaf to a similar vehicle from Nissan—the Versa Hatchback 1.8 SL. He prepares a model that 

determines the simple payback, return on investment (ROI), and the net present value (NPV), as shown in 

Figure 5.33. 

 

Figure 5.33. Comparison of an electric car to a car with a gasoline engine. 

This model has several assumptions that are explained in comments that are attached to cells A3, A4, 
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and A11. The potential buyer notices that even with the tax credit of $7,500 the electric car will cost $6,500 

more. This extra cost is offset by the lower cost of using electricity which produces a savings of $991 per 

year. The potential buyer wants to know what values for different inputs would result in a net present value 

of zero which is also called the break-even point.  

If the other inputs remain the same and the value for miles driven in cell B7 is increased to 2,000 

miles per month, the NPV changes to a positive $3,059. This implies that the break-even value for miles 

driven is between 1,000 and 2,000 miles. If the next try is halfway between—1,500—the NPV is $761 which 

indicates the break-even is less than 1,500. Using the results as feedback, the person gets pretty close within a 

few tries with a guess of 1,335, as shown in Figure 5.34. 

 

Figure 5.34. Repeated tries get close to the break-even value. 

Each repetition of the procedure is called an iteration. The Excel Goal Seek feature will do this 

process hundreds of times in less than a second. The Goal Seek procedure is found under the What-if 

Analysis button in the Data Tools group, on the Data tab. It has three arguments; the output cell, the desired 



   

 

43 | P a g e  

 

result, and the changing cell, as shown in Figure 5.35. 

 

Figure 5.35. Goal Seek uses iterations to find the desired outcome. 

The program follows a similar procedure of trying different numbers in cell B7 and using the output 

in cell B20 to adjust its next guess. It quickly determines that the breakeven for miles driven is 1,334 miles, 

as shown in Figure 5.36. 
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Figure 5.36. Break-even for miles driven. 

1. In Ch05FinancesStudentName, click the Hybrid sheet tab, if necessary. The investment in a car that gets 

higher gas mileage will have better financial comparison values for those who drive more miles. 

2. Click cell B34. This cell contains the net present value. If this value is zero, it means that the value of the 

savings equals the original investment. 

3. On the Data tab, in the Data Tools group, click the What-if Analysis button, and then click Goal Seek. 

4. Confirm that B34 displays in the Set cell box. 

5. In the To value box, type 0 

6. Click the By changing cell box and then click cell B3. Observe that the program makes the reference 

absolute, as show in Figure 5.37. 



   

 

45 | P a g e  

 

 

Figure 5.37.Three arguments for the Goal Seek function. 

7. Click OK. The program determines that the car would have to be driven more than 34,000 miles a year 

for the savings in gasoline to pay for the investment in the hybrid technology. 

8. In the Goal Seek Status dialog box, click Cancel. The original values are restored. 

9. Click cell B34. Another option that should improve the financial comparison numbers is a higher price of 

gasoline. Use the skills you just practiced to determine what price of gasoline (changing cell B4) would 

be the break even (To value of zero) for the net present value (Set cell B34). The answer will be between 

six and seven dollars in cell B4. Close to the actual price of gasoline in some European countries. 

10. In the Goal Seek Status dialog box, click OK. To keep this figure for the price of gasoline. 

Scenarios 

If calculations depend upon several independent variables, comparisons are more difficult because there are 

so many possible combinations. One way to deal with this problem is to record combinations of values that 

make up a scenario and give each scenario a name. The Scenario Manager in Excel helps with this task. The 

results of the scenarios can be compared one at a time or in a table. 

For example, in the exercise where purchasing a new high-efficiency furnace is evaluated, there are 

seven independent variables; cost of the furnace, tax credit, loan interest rate, payments per year, number of 

years, savings per year, and the expected annual increase in savings. There are thousands of possible 

combinations of these values. To perform a what-if analysis, begin with a likely set of values for the first 

scenario, and then create other scenarios where each value in turn is given its highest or lowest possible 
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value. For example, the longest available loan period or the lowest or highest tax credit.  

To identify the values, the labels in the table can be used as names for the cells that contain the 

values. This practice makes it easier to understand the dialog boxes in the scenario manager and the labels in 

the summary tables. The cells that can be changed are called changing cells. For example, if the seven inputs 

for the loan are named and then selected, the Scenario Manager provides a dialog box where the scenario can 

be given a name, and then the input values for that scenario can be entered, as shown in Figure 5.38. 

 

Figure 5.38.Scenario manager records values for the QuarterlyPayment scenario. 

The program saves the input values for the scenario. If one or more of the values are changed, they 

can be recorded as a different scenario. For example, if the number of payments is changed to twelve, a 

scenario named MonthlyPayments can be recorded. Several scenarios can be created such as NoTaxCredit 

where the tax credit is zero or LowInterestLoan where the interest rate is 2%. Once several options are 

recorded as scenarios, the Scenario manager can plug each set of values into the changing cells to facilitate 

comparison, as shown in Figure 5.39. 
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Figure 5.39.Scenario manager records values in changing cells to facilitate comparisons. 

The scenario manager can produce a table of the variables that shows the effect of the variables on a 

particular cell. The Summary option will produce a summary report that shows the results of selected 

financial measurements for each scenario, as shown in Figure 5.40. 

 

Figure 5.40.Summary report produced by the scenario manager. 

1. In Ch05FinanceStudentName, click the Hybrid sheet tab. 

2. On the Review tab, in the Changes group, click Unprotect Sheet. First, we will assign names to the 

changing cells. 
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3. Drag A3:B5. Press and hold the CTRL key, and then drag the following cell ranges; A7:B7, A12:B14, 

A18:B18, A20:B20, A24:B24, and A33:B33. Compare your screen to Figure 5.41. 

 

Figure 5.41.Changing cells and their labels selected. 

4. On the Formulas tab, in the Define Names group, click Create from Selection. 

5. In the Create Names from Selection dialog box, confirm that Left Column is checked. The labels in 

column A will be used to create names for the corresponding cells in column B. 
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6. Click OK. At the left end of the Formula bar, click the Name box arrow. The labels from the cells in 

column A are now names of the corresponding cells in column B. Compare your screen to Figure 5.42. 

Observe that the list of names is sorted alphabetically and that spaces are replaced by underscore 

characters. Cell names cannot have spaces. 

 

Figure 5.42.List of cell names. 

7. On the list, click Price_of_Gasoline. Observe that cell B4 is selected. Confirm that the value is $6.65 or 

type the value into the cell. 

Tip: A cell can be named in several ways. One simple method is to click the cell and then type a name in 
the Name box on the Formula Bar. Once a cell is named, the name may be used in formulas, dialog 
boxes or as argument functions to make them more understandable. Like chart labels, shorter is usually 
better for labels. For more options, the Define Name option is available in the Defined Names group on 
the Formulas tab. One of the options available from this dialog box is to limit the use of the name to a 
particular worksheet. 

8. On the Data tab, in the Data Tools group, click the What-If Analysis button. On the menu, click Scenario 

Manager. 

9. In the Scenario Manager dialog box, click the Add button. 

10. In the Add Scenario dialog box, in the Scenario name box, type Tax on Gasoline 

11. Click the Changing Cells box, and then use the skills you practice earlier for selecting cells to select all of 

the cells that have borders. Click OK. A list of the selected cells is displayed in the dialog box, as shown 

in Figure 5.43. 
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Figure 5.43.Current values in all of the changing cells are captured and saved as a scenario 

named Tax on Gasoline. 

12. Click OK. The scenario manager shows one scenario, Tax on Gasoline. Click Close. 

13. Click cell B4, and then type $2.91 to return it to its original value. 

14. On the Data tab, in the Data Tools group, click the What-If Analysis button and then click Scenario 

Manager. 

15. In the Scenario Manager, click the Add button.  

16. In the Add Scenario dialog box, in the Scenario Name box, type No Changes and then click OK.  

17. In the Scenario Values dialog box, click OK. 

18. In the Scenario Manager dialog box, under Scenarios, click Tax on Gasoline, and then click the Show 

button. Observe that all of the recorded values from the Tax on Gasoline are placed in the changing cells, 

specifically the price of gasoline.  

19. Click the No Changes scenario, and then click the Show button. Observe that the values are returned to 

their original values that are stored as the No Changes scenario. 

20. Click the Close button. 

21. Use the Goal Seek feature to find the tax credit in cell B14 that would be necessary to achieve a 

breakeven NPV value of zero. Record the values in the changing cells as a scenario named Tax Credit 

22. Use the scenario manager to restore the original values. Close the scenario manager. 
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Tip: The scenario manager can summarize the effects of the different scenarios on the financial 
comparison values of simple payback, ROI, and NPV. To make the summary more readable, those results 
cells should be given names. 

23. Use the skills you practiced earlier to assign names to cells C30, C31, and C34 using the labels to the left. 

24. Click cell C28. On the Formula bar, at the left in the Name box, type Cash_Flow_2012 and then press 

Enter. This assigns the name to cell C28. 

25. On the Data tab, in the Data Tools group, click the What-If Analysis button and then click Scenario 

Manager. In the Scenario Manager, click the Summary button. 

26. In the Scenario Summary dialog box, confirm that Scenario Summary is selected, and then in the Results 

cells box, type B30,B31,B34,C28 Compare your screen to Figure 5.44. 

 

Figure 5.44. Addresses of the cells that show the payback, ROI, NPV, and cash flow for 

2012. 

27. Click OK. Observe that the program creates a new worksheet and places a summary of the effects of each 

summary on the designated results cells as shown in Figure 5.45. 
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Figure 5.42. Scenario summary. 

28. Save the workbook and submit it as directed by the instructor. 

Key Takeaways 
 A what-if analysis is produced by trying different options to see what happens. A 

worksheet should be designed to make this easy to do by locating the variables that are to 

be changed in one location and then writing all the formulas that use those values with 

references to the cells. Cells that are intended for changes can be visually identified with 

borders or background colors. Accidentally overwriting cells with formulas can be avoided 

by using protection. The changing cells can be unlocked from the worksheet so that when 

the worksheet is protected from change, those cells are not. [5.4.1] 

 To find an input value that produces the desired result from a calculation, use Goal Seek 

from the What-If Analysis in Data Tools on the Data tab. Specify the cell that has the 
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formula—the results cell—and the desired outcome, and then choose one cell upon which 

the calculation depends—the changing cell. The program will try different values in the 

changing cells to produce the desired result in the results cell. [5.4.2] 

 A scenario is a set of values used in the changing cells. Each set of values is given a 

scenario name. To show the effect on a given set of values, the scenario can be chosen and 

the values are entered into the changing cells. [5.4.3] 

 A fast way to use the labels next to the cells as cell names is to select both and then on the 

Formulas tab, in the Defined Names group, click Create from Selection. Another option is 

to select the cell and type the name into the name box with is at the left end of the formula 

bar. [5.4.4] 

 The effect of the values in each scenario on a particular output cell can be demonstrated 

with a summary report or a PivotTable that is created from the Scenario Manager. [5.4.5] 

 

Key Terms 

Break-even 

The input values at which the project goes from a loss (negative NPV) to zero. 

Cash flow 

Transfer of money into and out of an account where out is negative and in is positive 

Changing cells 

Cells that contain values used by calculations in other cells. 

Declining balance depreciation 

Percentage of the balance of the value is depreciated each period 

Depreciation 

Reduction in value. 
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Discount rate 

Percentage by which future dollars are reduced in value each year for comparison with today’s dollars. 

Feedback 

Information about the results of a calculation that might be used to change the input. 

Goal Seek 

Functino in Excel that finds a desired output from a calculation by changing the input values. 

Iteration 

Repeated effort. 

Locked 

Protection settings of cells are syncronized with the protection settings of the worksheet. 

Money 

Quantitative tool for representing value of goods and services. 

Net present value (NPV) 

Sum of the present values of several future incomes or expenses. 

Protected 

Prevents accidental changes to worksheets. 

Quarterly 

Four times a year. 

Return on Investment (ROI) 

The ratio of the difference between gains and cost to the cost. 

Scenario 

Collection of values used as inputs. 

Shareholders 

People who own part of the company. 

Simple payback 

Amount spent divided by the amount saved or earned. 

Spreadsheet 

Range of calculations that project the effects of financial decisions usually arranged in a table. 
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Straight line depreciation 

Equal percentages of the item’s original value are deducted from its value each time period. 

Subsidy 

Transfer of money to reduce the initial cost. 

Tax deduction 

Reduction in income before taxes are calculated. 

Tax credit 

Reduction in the amount of tax owed. 

Threshold 

Boundary value used to make decisions. 

What-If Analysis 

Observing the effect on calculations of changing the cells upon which they depend for input data. 
 
Last edited on January 6, 2011 


